
From the Editor:
Apple has released new MacBook Air models, a new Mac mini, and Lion. This issue of the newsletter was 
compiled using Lion. There were some interesting words said and several hmmm’s but generally it works pretty 
well. Apparently the iWork and Safari updates work well with Lion. NB: No MacApps SIG in August and the 
Mac Q&A SIG has moved to Wednesday night, same location,

Lion can be downloaded from the App Store for $29.00 or, if you have dial-up or a slow internet connection, 
you can make an appointment at your local Apple Store to download it there. Also note some interesting hot 
links.

Tom Ostertag, Publications Director
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 Jeff Tranberry
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SPECIAL ANNOUNCEMENT
by Tim Drenk

On September 15th, mini’app’les will host a general 
meeting for all members. The focus will be a series 
of mini-presentations on Mac, Mac OS X Lion, and 
iOS followed by a general Mac/iOS Q&A session. 
We will also spend a few minutes discussing some 
upcoming changes to the mini’app’les website. To 
lighten the load on your schedule, and encourage 
participation of all members, the Mac OS X SIG, the 
Mac Apps SIG, the iOS SIG, and the Mac Q&A SIG 
will not meet in September. (The Filemaker and 
Photoshop/Lightroom SIGs will meet according to 
their published schedules.)

We want to make general meetings an ongoing event 
(2-4 times/year). Our hope is that this will promote a 
greater sense of community and allow us to present 
topics of general interest to a larger audience. In 
turn, a larger audience will attract presentations from 
a wider variety of developers and vendors. As the 
general meetings attract new members, we want 
them to find a SIG that interests them as well.

The general meeting, like all of our SIG meetings, is 
open to the public and you should encourage friends 
and colleagues to attend. It would be great to see 

some new faces amongst old friends and we'd love to 
"pack the house" for the inaugural event.

The topics haven't been finalized yet so if you have a 
suggestion, or better yet, you want to give a 15-20 
minute presentation yourself, please contact Tim 
(timdrenk@miniapples.org) or Jeff 
(jeff@purpleshark.com).

MacApps SIG Meeting Report – July 7, 2011
by Tim Drenk

We looked at Bento and preparing for Lion. 
Here are a few things we covered.

Bento
First, we looked at the difference 
between using a spreadsheet vs. using 
a database (text, numbers, formulas vs. 
data storage, multiple views, relational). The cost of 
Bento v4 is $50 for the full version (available from 
the App Store and other resellers) and $30 to 
upgrade from a previous version (from FileMaker’s 
store). Since Bento is FileMaker’s “Personal” 
database program, it is designed with a single user in 
mind. While it does have some sharing capabilities, 
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FileMaker is better suited for a multiuser 
environment. We discussed some Bento Terminology 
as we looked at how Bento organizes information:
• Field: A single data element
• Record: A single set of fields
• Libraries: A set of records
• Collections: Similar to iTunes’ playlist

We walked through the different features and 
functions in the Bento Window and looked at several 
of the Templates like the Bento Label Kit and Bento 
Contact & Customer Manager.

Preparing for Lion
(Since Lion was released on the 20th, I have added a 
few comments)
Mac OS X Lion System Requirements
To install Mac OS X 10.7 you will need:
• Intel Core 2 Duo, Core i3, Core i5, Core i7, or 

Xeon processor (newer than mid 2007)
• 2GB of RAM
• Mac OS X 10.6.6 or later with the Mac App 

Store installed
• At least 4GB of additional disk space to 

accommodate the download, but more is 
obviously recommended

Comments
• You need Mac OS X 10.6.6 or greater (which is 

required for the Mac App Store) to download 
Mac OS X 10.7 Lion from the Mac App Store 
(Lion can also be downloaded at the Apple Store 
if you bring in your computer or Apple will make 
Lion available on a USB flash drive for $69)

• The Lion installer is an appication (app) that is 
started from the existing Snow Leopard 
installation. (The installer app will be deleted 
from the computer at the end of the install 
process. If you want to install Lion on multiple 
computers, you can download the installer again 
from the App Store or copy the installer app to a 
different location or drive before you start the 
install process.)

• Lion can be installed as an upgrade for Snow 
Leopard, but it can also be installed as a clean 
install on a new hard drive or blank partition. To 
do a clean install, you can create a bootable Lion 

installation DVD from an image inside the 
downloaded installer. This is not supported by 
Apple.

Programs
• Programs written for the PowerPC will not work 

in 10.7. To find out if a program is PowerPC, 
Intel, or Universal, use the Applications section 
of System Profiler. RoaringApps (http://
roaringapps.com/) is one source to check 
compatibility. Note: Rosetta programs are at least 
5 years old

• There are number of programs that need to be 
updated to run properly in 10.7, especially 
system level programs. Be aware of any added 
system preferences or menu bar items running on 
your system and check their compatibility with 
10.7.

!"#$The Mac Apps SIG will not meet in August.

iOS SIG Meeting • 12 July 2011
by Joel Gerdeen

An iOS SIG meeting was 
held at 7:00 pm on 
Tuesday, July 12, at the 
Southdale Library. This 
SIG focuses on iOS 
devices such as iPhones, 
iPad, and iPod touches. 
We discussed iOS 5 and 
iCloud which were 
announced by Apple at 
the WWDC in early June. 
Most of the information discussed can be found on 
Apple’s web site, www.apple.com. We also 
discussed updates to the iWork apps; Pages, 
Keynote, and Numbers. Updates to Garageband and 
iMovie were also presented. New browsers, Mercury  
and Atomic Web, were compared along with updates 
to the Bento database manager. Finally a new 
notepad app, WhiteNote, was introduced. A copy of 
the presentation with links to app web pages can be 
found here. 
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The next meeting is planned for Tuesday, August 9, 
at 6:30 PM at the Southdale Library Public 
Conference meeting room. The meeting will 
continue discussion of iOS 5 and iCloud from actual 
usage of the beta version over the ensuing month. As 
usual, any interesting apps released during the month 
will also be presented. For those interested, the 
meeting will continue at Bakers Square afterwards.

Update Migration Assistant before 
Upgrading to Lion
by Adam C. Engst
Stop the presses! Wait! 
We don’t have presses! 
That’s good, since 
Apple has just released 
Migration Assistant 
Update for Snow 
Leopard, which is described somewhat blandly 
despite the rather irritating consequences:

This update addresses an issue with the Migration 
Assistant application in Mac OS X Snow Leopard 
that prevents transfer of your personal data, settings, 
and compatible applications from a Mac running 
Mac OS X Snow Leopard to a new Mac running 
Mac OS X Lion.

Although it’s unclear how prevalent this bug is (we 
haven’t run into migration problems during the 
testing of Joe Kissell’s “Take Control of Upgrading 
to Lion”) and Apple implies that it applies only to a 
new Mac running Lion, we still recommend getting 
this update via Software Update or the Apple 
Support Downloads page (where it’s a 714 KB 
download) before upgrading to Lion. And if you’re 
planning on buying a new Mac that has Lion pre-
installed and migrating your data over to it from a 
Mac running Snow Leopard, you’d be silly not to 
download this Migration Assistant update first.
Copyright © 2011 Adam C. Engst. TidBITS is copyright © 
2011 TidBITS Publishing Inc. Reuse governed by Creative 
Commons License.

Our Favorite Hidden Features in Mac OS X 
Lion
by TidBITS Staff
A major operating system update is a large, complex 
beast (and in this case, a beast that roars and eats 
gazelles for lunch). Apple touts top-tier Lion features 
like Launchpad, Mission Control, and extensive 
gesture support, but hundreds of improvements and 
changes abound. We’ve collected an assortment of 
fun and useful tips that you’ll want to try during 
your first few hours with Lion.

You’ll learn about even more Lion features — 
complete with far more detail than you’ll find here 
or anywhere else online — in Matt Neuburg’s 167-
page “Take Control of Using Lion,” available now 
for $15.

Getting Comfortable in the Finder -- The Finder is 
typically the first thing you see when you use your 
computer (although with Lion’s new Resume 
feature, that may be less true than in the past), and 
you may be a little disoriented when you first try to 
use it in Lion. These hints will get you past those 
first few moments:

• All My Files is a new smart folder, and you’ll 
be hard pressed to miss it, since it appears 
first in the default Finder window sidebar. (A 
smart folder is a saved Spotlight search.) If 
you prefer not to use it, you can remove its 
listing from the sidebar using the contextual 
menu or by choosing Finder > Preferences. 
You may find it more convenient to hide All 
My Files and to add your Home folder to the 
sidebar in its place (again, you can do this 
with Finder > Preferences).

• To remove something from the Finder 
sidebar, hold Command as you drag it out. 
(This was actually introduced in a late 
version of Snow Leopard, but it continues to 
bedevil people; see “Mac OS X 10.6.7 
Changes Finder Sidebar Behavior,” 18 May 
2011.)
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• The default display of All My Files may 
catch your eye because it uses the Finder’s 
new Arrange feature. This cool new feature 
groups files, and labels each group. The 
Finder window toolbar contains a new 
Arrange pop-up menu to make grouping 
easy. But then what about sorting? The secret 
is to hold the Option key as you choose from 
the menu; this changes Arrange to Sort. If 
you sort when there is already an Arrange 
option in force, you sort within each group. 
(For a fun visual example of arranging in 
Lion, open the Applications folder into Icon 
view, arrange by application category, and 
then, if you have a trackpad or Magic Mouse, 
swipe horizontally back and forth over a 
category.)

• You can now select several items in the 
Finder and choose File > New Folder with 
[number] Selections to put them all into a 
new folder.

• The top-level Applications folder has new 
permissions that make it hard to remove 
anything; if you try to drag something out of 
the Applications folder, it may stay there, and 
you’ll get an alias instead. The solution is to 
hold Command as you drag. (If even that 
doesn’t work, it’s because the application 
belongs to Apple, not to you, and you’re no 
longer allowed to move it.)

• You may not have used copying and pasting 
in the Finder much in the past, as a way of 

moving items from one folder to another, 
because in the past it didn’t move them: it 
only copied them, causing you to end up with 
two copies of everything you pasted. But in 
Lion if you hold Option when pasting a 
copied Finder item (Command-Option-V), it 
really does move it.

• When you copy one file over another with 
the same name, you’re asked whether you 
wish to replace the existing file. But now, 
you can also click the Keep Both Files 
option. The existing file appears with “copy” 
appended to the name.

• When you’re viewing the list of results from 
the Spotlight menu, hover the pointer over an 
item to view a new Quick Look panel to 
preview the item’s contents.

Meeting Mission Control -- Mission Control is just 
Exposé by another name, with Spaces folded in 
(there is no longer a separate Spaces control panel or 
application; instead, spaces are manipulated at the 
top of the Mission Control screen). It’s easy to use, 
but here are some hints:

• To add or delete a Desktop space, hold 
Option to make the big Plus button and the 
“x” buttons appear in a corner of your screen. 
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• To navigate to a space without leaving 
Mission Control, hold Option as you click 
the space.

• To get a better look at a window, hover the 
pointer and press the Spacebar.

• You’ll probably discover full-screen 
windows immediately; Safari and Mail, for 
example, offer you the chance to turn a 
window into a full-screen window (look for a 
button near the upper right of the window). 
What may not be obvious is that full-screen 
windows occupy their own spaces, shown at 
the top of the Mission Control screen. You 
can navigate to and from them just like 
navigating to and from spaces (and if you 
have a trackpad or Magic Mouse, there are 
handy gestures for this). When working in a 
full-screen window, hover the pointer near 
the top of the screen to summon the menu 
bar. One obscure trick is that to get a window 
out of full-screen mode, you can simply press 
the Esc key.

Connect to Other Members of Your Pride -- In 
addition to adding AirDrop for easy file transfers 
between nearby computers, a few other networking 
features stand out:

• In Lion, screen sharing is easier than before - 
you can now log in and control a user 
account, even if the computer is actively 
being used by someone with a different user 
account.

• Lion eschews Apple’s 12-year-old 
trademarked term AirPort to describe 
wireless local area networking in favor of 
Wi-Fi, the industry-standard certification 
term. The AirPort menu and other items 
throughout the Mac OS X interface are now 
labeled Wi-Fi.

• Lion updates the hoary software base station 
feature, found in the Sharing preferences 
pane in the Internet Sharing service, to allow 
the use of four channels in the 5 GHz band. 
Internet Sharing turns a Mac into the 

equivalent of a Wi-Fi router, but until Lion, it 
was limited to the crowded 2.4 GHz band. 5 
GHz is much less crowded, and can provide a 
better chance at a high-speed signal, even 
though the signal won’t travel nearly as far as 
an equivalent 2.4 GHz channel. Channels 36, 
40, 44, and 48 are all available to Internet 
Sharing, as well as to Computer-to-Computer 
(ad hoc) networking (an option in the Wi-Fi 
menu). 

• Sadly, Apple left intact WEP-only security, 
which is easily broken, and causes 
incompatibility with some devices that have 
802.11n built in, such as some Android 
phones.

Text in Context -- As soon as you begin working 
with text in Lion, you’ll begin to notice differences, 
such as:

• Lion gains iOS-style autocorrect features as 
you type. When Lion detects a potentially 
misspelled word, an alternative appears in a 
small box below the one you’re typing — 
press the Spacebar or punctuation to accept 
the alternative, or press Esc or click the small 
X icon to dismiss the suggestion.

• Can’t remember which key combination 
creates an accented letter, such as “é”? Press 
and hold a key to bring up accented 
alternatives, a feature introduced in iOS. You 
can click the accent you want, or, since your 
fingers are already on the keyboard, press the 
number that appears below the character you 
want.

• Apple now includes an emoji font (Apple 
Color Emoji) for adding emoticons. To 
access dozens of symbols, bring up the 
Characters palette in an app such as TextEdit 
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or iChat, select Emoji, and locate the picture 
you want.

Pimp Your Preferences -- System Preferences has a 
couple of hidden new features:

• To reduce the number of icons shown in the 
main pane of System Preferences, choose 
View > Customize. The result is that all icons 
acquire checkboxes, which you can uncheck 
to specify that a particular icon shouldn’t 
appear. In this way, you can reduce the icons 
to those you normally use. No functionality 
is lost, because you can still navigate to any 
preference pane using the View menu.

• There’s a new way to see the View menu. 
Instead of going into the menu bar, hold 
down on the Show All button at the top left 
of the System Preferences window.

A Miscellany of Tricks -- Here are some 
miscellaneous tricks you might not have known 
about:

• You can now display a custom message on 
the login or lock screen (for example, your 
name and contact information in case the 
computer is found). Open the Security & 
Privacy preference pane, enable the “Show a 
message when the screen is locked” option, 
and enter your text.

• Horrified by the new look of Mail? In Mail, 
choose Mail > Preferences. Click the 
Viewing button, and select “Use classic 
layout,” to restore the old tripartite display.

• In the category of “Why did it take so long to 
implement this obvious feature?”, you can 

now drag a file from Safari’s downloads list 
to move the downloaded file to a new 
location in the Finder.

• Auto Save already applies to a few Apple 
applications, and third-party apps are starting 
to come on board with this feature. It’s pretty 
obvious how to use it (mostly you don’t use 
it; you just save a new document once and 
then let the system save it from then on). But 
here’s one non-obvious feature: to determine 
how long must elapse before an autosaved 
document is automatically locked (so you 
can’t accidentally change it), access the 
setting in the Time Machine system 
preference pane (which is silly, as this lock 
has nothing whatever to do with Time 
Machine).

• Do you hate “inertia,” where a window keeps 
scrolling after you end your scroll gesture? 
The pop-up menu to turn it off is hidden in 
the Universal Access system preference pane. 
Click the Mouse & Trackpad button (or just 
the Mouse button) and then click Trackpad 
Options (or Mouse Options).

• Want nicer text-to-speech voices? There are 
now lots to pick from. Open the Speech 
system preference pane, click Text to Speech, 
and from the System Voice pop-up menu 
choose Customize. You can sample all 
voices, but the unchecked ones are not 
installed; selecting one and clicking OK will 
start downloading it via Software Update. 
(Hint: try the British-accented Daniel.)

• Lion’s new Resume feature automatically 
opens any application’s documents that were 
active when the app was quit. That can be 
jarring to people who traditionally quit an 
app when finished with a document. To 
ensure that a completed document does not 
automatically open the next time you launch 
the application, hold Option and choose [the 
Application Name] > Quit and Discard 
Windows, or press Command-Option-Q. 
Alternatively turn this feature off completely 
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in the General system preference pane; you 
can then ensure that an open document does 
automatically open the next time you launch 
the application, again by holding Option as 
you quit the application.

• To prevent all applications from reopening 
when you restart your Mac, do not hold 
Option as you choose Apple > Restart or 
Apple > Shut Down - so that the dialog 
appears - and uncheck "Reopen windows 
when logging back in."

This article is copyright © 2011 TidBITS Staff TidBITS is 
copyright © 2011 TidBITS Publishing Inc. Reuse governed by 
Creative Commons License.

New Mac mini Adds Thunderbolt and Faster 
CPUs, Drops Optical Drive
by Adam C. Engst
Along with Mac OS X Lion’s release today, Apple 
also updated the Mac mini, giving the diminutive 
desktop Mac new processors, discrete graphics, a 
Thunderbolt port, and more, while at the same time 
removing the previous model’s optical drive. The 
new Mac mini’s industrial design remains the same, 
and it ships with Mac OS X Lion pre-installed.

More so than other Macs of recent times, the Mac 
mini comes in three rather different models, making 
the decision of what to get more confusing than in 
the past. The models are:

• 2.3 GHz Mac mini: The $599 low-end model 
features a 2.3 GHz dual-core Intel i5 CPU, 
along with 2 GB of RAM (upgradable to 4 or 
8 GB for $100 or $300 more), a 500 MB 
5400-rpm hard disk (with a 750 GB disk as an 
option for $150 more), and built-in Intel HD 
Graphics 3000 that shares 288 MB of RAM 
with main memory.

• 2.5 GHz Mac mini: The $799 higher-end 
consumer model of the Mac mini provides a 
choice of either the 2.5 GHz dual-core Intel i5 
CPU, or a 2.7 GHz dual-core Intel i7 (add 
$100). It ships with 4 GB of RAM standard 

(upgradable to 8 GB for $200), and provides a 
selection of storage options, including the 
default 500 GB 5400-rpm hard drive, a 750 
GB hard drive (add $150), a 256 GB solid-
state drive (add $600), or a 750 GB 7200-rpm 
hard drive plus a 256 GB solid-state drive 
(add $750). Along with the faster processors, 
this Mac mini includes a discrete graphics 
processor, the AMD Radeon HD 6630M with 
256 MB of dedicated GDDR5 memory. It 
should increase graphics performance by as 
much as two times.

• 2.0 GHz Mac mini with Lion Server: The 
$999 server configuration of the new Mac 
mini relies on a 2.0 GHz quad-core Intel Core 
i7, provides 4 GB of RAM (upgradable to 8 
GB for $200 more), and ships with a pair of 
500 GB 7200-rpm hard drives. You can trade 
out the drives for a pair of 750 GB 7200-rpm 
hard drives (add $100), a 256 GB solid-state 
drive (add $400), a 750 GB 7200-rpm hard 
drive plus a 256 GB solid-state drive (add 
$550), or a pair of 256 GB solid-state drives 
(add $1000). Since servers don’t generally 
have significant graphics needs, it too relies 
on the built-in Intel HD Graphics 3000 that 
shares 288 MB of RAM with main memory. 
And, of course, it ships with Lion Server pre-
installed.

In terms of video specs, the new Mac mini includes a 
single Thunderbolt port with support for up to 2560 
by 1600 resolution on a connected monitor, an 
HDMI port with support for up to 1920 by 1200 
resolution, and DVI output via an included HDMI-
to-DVI Adapter. On the audio side, the Mac mini 
includes an audio line-in minijack, a line-out/
headphone minijack, support for the Apple iPhone 
headset with microphone, and a built-in speaker.

Standard expansion ports beyond the single 
Thunderbolt port and the HDMI port include a 
FireWire 800 port, four USB 2.0 ports, an SDXC 
slot, and a Gigabit Ethernet port. Speaking of 
networking, the Mac mini supports 802.11n Wi-Fi, 
along with Bluetooth 4.0. For those desperate for 
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fast storage via Thunderbolt, Apple is selling the 
Promise Pegasus RAID systems and Thunderbolt 
cables now; as far as we know, they’re the only 
Thunderbolt peripherals aside from the new 
Thunderbolt Display available so far.

None of the Mac mini models come with an optical 
drive built-in, but you can add the USB-based 
MacBook Air SuperDrive for $79. Also still missing 
are a keyboard and pointing device; you can use 
existing devices or buy new ones from Apple as you 
wish.

As with most of Apple’s recent hardware updates, 
the new Mac mini provides welcome changes at the 
same price points as the previous models, although 
it’s possible that some people will be distressed by 
the loss of an internal optical drive. It is a bit 
surprising that Apple is so thoroughly differentiating 
the different models rather than just enabling 
customers to configure a base model with all the 
various options.
Copyright © 2011 Adam C. Engst. TidBITS is copyright © 
2011 TidBITS Publishing Inc. Reuse governed by Creative 
Commons License.

TidBITS Watchlist: Notable Software 
Updates for July
by TidBITS Staff 
Safari 5.1 and 5.0.6 -- New from Apple is Safari 5.1 
for Mac OS X 10.6 Snow Leopard, which brings the 
company’s Web browser on par with the version 
installed on 10.7 Lion. Safari 5.1 includes several 
new features, including Reading List, which enables 
users to create a list of Web pages they can then 
examine at a later date; Resume, which 
automatically restores all open windows and tabs 
when you relaunch Safari; and a Privacy pane that 
makes it easier to remove browsing data from your 
system. In addition, Safari 5.1 supports a new 
process architecture that separates the user interface 
from rendering operations, providing better 
performance and more stability, particularly when 
using third-party plug-ins. Other improvements 
highlighted by Apple include private auto-fill, better 

search functionality, drag-and-drop for moving files 
from the Downloads window, improved support for 
modern Web technologies like HTML5 and CSS3, 
and new APIs for extension developers.

Separately, the company has also released Safari 
5.0.6 for Mac OS X 10.5 Leopard, which focuses 
exclusively on fixing issues related to the rendering 
of HTML5 content, the layout of several Web sites, 
and general stability. (Free updates; Safari 5.1: 47.47 
MB; Safari 5.0.6: 52.51 MB)

Windows Migration Assistant for OS X Lion 1.0 
-- Apple has released Windows Migration Assistant 
for OS X Lion 1.0. Much like Migration Assistant on 
the Mac, this new app makes it possible for users of 
Windows XP (with Service Pack 3), Windows Vista, 
and Windows 7 to migrate their profile and user data 
from a PC to a Mac running Mac OS X 10.7 Lion. 
(Free, 2.78 MB)

Server Admin Tools 10.7 -- Apple has released 
Server Admin Tools 10.7 to provide compatibility 
with Mac OS X 10.7 Lion Server. Included are 
updated versions of Podcast Composer, Server 
Admin, Server Monitor, System Image Utility, 
Workgroup Manager, and Xgrid Admin. (Free, 
193.25 MB)

iTunes 10.4 -- Apple’s iTunes has been bumped to 
version 10.4, receiving no user-level changes but 
gaining a 64-bit foundation for maximum 
performance on Mac OS X 10.7 Lion; the update 
also includes several unspecified performance and 
stability improvements. Apple notes that, due to the 
architectural changes entailed by the move to 64-bit, 
third-party plug-ins may stop working with this 
version of iTunes; if that happens, contact the 
individual plug-in developers for help. (Free, 90.23 
MB, release notes)

Java for OS X Lion -- By default, Mac OS X 10.7 
Lion doesn’t come with a Java runtime, but this 
doesn’t mean that users who need to run Java apps 
(such as the popular CrashPlan) are out of luck. 
Apple now makes Java SE 6 1.6.0_26 available as a 
separate download that the operating system will 
automatically attempt to install whenever users try to 
run a Java app, or that can be downloaded separately 
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from the company’s support Web site. Apple 
recommends that all Web browsers be closed prior to 
beginning the installation process. (Free, 62.53 MB)

iWork 9.1 -- Apple has released iWork 9.1, a 
relatively small but significant update that brings 
Lion compatibility to its office suite. All iWork apps 
have been updated to support several major Lion 
features, including full-screen mode, Resume, Auto 
Save, and Versions (see “Apple Reveals More about 
Mac OS X Lion,” 24 February 2011). Rounding out 
the new release are two new builds for Keynote 
presentations, general improvements to the suite’s 
compatibility with Microsoft Office, and security 
fixes to handle maliciously constructed Excel and 
Word files. iWork 9.1 is available as a free update 
through Software Update, but updates to Pages, 
Numbers, and Keynote are also available through the 
Mac App Store. (Free update, 90.2 MB)

Apple Remote Desktop 3.5 Admin -- Apple has 
released Remote Desktop 3.5 Admin, an update to its 
remote desktop management software that 
introduces several reliability, usability, and 
compatibility improvements — at least some likely 
connected to the company’s recent release of Mac 
OS X 10.7 Lion and Mac OS X 10.7 Lion Server. An 
updated version of the app’s companion Dashboard 
widget has also been released. ($79.99 new from the 
Mac App Store, free update through Software 
Update or the Mac App Store, 25.27 MB)

SuperDuper 2.6.4 -- New from Shirt Pocket is 
SuperDuper 2.6.4, an update to the popular drive-
cloning and backup software. Version 2.6.4 is 
primarily a maintenance release that concerns itself 
with improved compatibility with Mac OS X 10.7 
Lion and introduces a number of bug fixes. These 
include an issue that was causing copying operations 
on highly active files to fail and an incompatibility 
between the app’s AppleScript dictionary with Mac 
OS X 10.5 Leopard. SuperDuper now also prevents 
copy destinations from being ejected during a copy 
operation. (Free for basic functionality, $27.95 for 
additional features, free update, 2.9 MB)

Things 1.5.0 -- Cultured Code has released Things 
1.5.0, a minor update to its task organization app that 

improves its compatibility with Mac OS X 10.7 
Lion. Since version 1.4.5, released in March 2011, 
the app has received a number of bug fixes that 
affect everything from crashes to more subtle issues 
related to syncing with the software’s iOS 
counterparts, working in the background and various 
user interface elements. In addition, Cultured Code 
has added support for executing AppleScripts 
directly from within the software. ($49.99 new from 
Cultured Code or the Mac App Store, free update, 
8.0 MB, release notes)

MenuMeters 1.5 -- Alex Harper’s Raging Menace 
has released MenuMeters 1.5, an update to its open 
source system monitoring tool. The only notable 
change in this new version is support for Mac OS X 
10.7 Lion, which means that you will be able to 
continue using MenuMeters to keep an eye on key 
aspects of your Mac’s status, including memory, 
disk, and CPU usage, network activity, and much 
more. (Free, 883 KB)

Cyberduck 4.1 -- The Cyberduck team has released 
version 4.1 of the free file-transfer utility for Mac 
OS X. Cyberduck 4.1 adds support for navigation 
using trackpad gestures, allows users to upload 
arbitrary files to Google Docs, and introduces 
several improvements to its interface with Amazon’s 
S3 and CloudFront services, particularly in relation 
to storing data in different data centers and better 
managing log files. Rounding out the release are 
numerous bug fixes that correct issues ranging from 
managing the timestamps of uploaded files to 
ensuring that only trashed files are deleted in Google 
Docs. (Free, 22.9 MB, release notes)

Sparrow 1.3.1 -- Sparrow has updated its minimalist 
email client for Mac OS X to Sparrow 1.3.1. The 
minor release focuses on a critical bug that was 
affecting version 1.3, which, as the company 
mentions in a blog post, introduced a number of 
more-significant changes, including full 
compatibility with Mac OS X 10.7 Lion, improved 
access to labels and folders via the sidebar, and an 
integrated “send and archive” feature. In addition, 
the Sparrow team has rewritten all of the app’s 
animations, making its user interface smoother and 
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more interactive. ($9.99 new from Sparrow or from 
Mac App Store, free update, 14.8 MB)

Aperture 3.1.3 -- Apple has released Aperture 3.1.3, 
a minor update to its professional image 
management software. The new release introduces a 
number of small enhancements, particularly in the 
handling of accented letters and Korean, Japanese 
and Chinese scripts. Aperture is now also better at 
syncing albums to the Web and exporting 
slideshows, in addition to offering users more 
flexibility with enabling and disabling gestures. 
Rounding out the update are several bug fixes, which 
include correcting an issue that could cause a blank 
sheet to be displayed when placing a book or print 
order, addressing an issue that was preventing 
metadata presets from being applied correctly to 
imported audio files, and making the library repair 
and rebuild functions more reliable. Apple 
recommends the update for all users of Aperture 3. 
($79.99 new from the Mac App Store, free update 
through Software Update or the Mac App Store, 
292.02 MB)

Firefox 5.0.1 -- The latest Mac-only update to 
Mozilla’s open-source Web browser, Firefox 5.0.1, 
brings only two changes, but they’re important. First  
is a workaround for a crash that could occur in the 
forthcoming Mac OS X Lion when using 
downloadable fonts. Since downloadable fonts are 
quite common on the Web, Firefox 5.0 users would 
have seen significant numbers of crashes after 
upgrading to Lion. Second, Apple’s update to Java in 
Mac OS X 10.5 Leopard broke the Java plug-in in 
Firefox (see “Java for Mac OS X 10.6 Update 5 / 
Java for Mac OS X 10.5 Update 10,” 29 June 2011); 
version 5.0.1 enables Firefox to load the Java plug-in 
in Leopard once again. (Free, 27.8 MB, release 
notes)
Unless otherwise noted, this article is copyright © 2011 
TidBITS Staff TidBITS is copyright © 2011 TidBITS 
Publishing Inc.Reuse governed by Creative Commons License.

Alternatives to MobileMe for iWeb Sites
by Steve Sande

After Apple’s recent confirmation of the worst fears 
of iWeb users – that the hosting of iWeb sites as part 
of MobileMe will disappear on 30 June 2012 (see 
“Apple Details Transition from MobileMe to 
iCloud,” 24 June 2011), many readers of my “Take 
Control of iWeb ’09” ebook contacted me to find out 
where they should move their sites. There are a 
couple of options, depending on how serious your 
site is, and whether or not you have a custom 
domain.

Sites with Custom Domains -- For anyone with a 
unique (non-MobileMe) domain name or with a 
high-traffic Web site, my recommendation is to bite 
the bullet and sign up for a paid Web hosting account 
with a known hosting provider. The Web hosting 
provider you select is up to you, but some of the 
better-known hosts include DreamHost, Bluehost, 
HostGator, and GoDaddy. Prices start around $5 per 
month.

Once your new host has provided you with login 
information, launch iWeb and select your Web site in 
the sidebar to reveal the Site Publishing Settings for 
that site. You’ll need to enter the site name, your 
contact email address, and information (server 
address, user name, password, and initial path) for 
the FTP server associated with your site.
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Provide the site URL (which is used to set up links 
and RSS feeds) and decide whether or not you’d like 
to update your Facebook account each time you 
publish your site, and click Test Connection to make 
sure that all of your settings are correct. If they are, 
you’re ready to publish your iWeb site to the new 
host with a click of the Publish Site button.

You’ll also need to repoint your custom domain 
appropriately; contact tech support at your new 
hosting company if you need help doing that.

Sites in the MobileMe Domain -- If you’ve been 
happy with a MobileMe URL like http://
web.me.com/stevensande and don’t have significant 
traffic to your site, then a free hosting solution is 
probably all you need. The easiest is cloud storage 
provider Dropbox, which offers free 2 GB accounts 
that provide plenty of storage space for all but the 
largest iWeb sites. Follow along for a short tutorial 
on how to set up Dropbox and iWeb to host your 
iWeb sites.

One caveat: Although the suggestion for Web site 
hosting comes directly from the Dropbox wiki, the 
service is not intended for “production” Web 
hosting. A few personal pages or a testing site 
shouldn’t cause you any grief, but Dropbox does 
reserve the right to turn off your public links if the 
system detects unusual levels of bandwidth 
consumption.

1. To begin with, you must have a Dropbox 
account. If you don’t have one, go to 
Dropbox’s home page and download the 
Dropbox software, install it, and set up your 
account. I also suggest watching the video on 
the Dropbox home page to understand the 
concept behind the application and service.
(In essence, Dropbox mirrors the contents of 
the Dropbox folder in your home folder to 
the Dropbox servers, and syncs all changes to 
files in that folder up to Dropbox’s servers, 
and then down to all your other devices. If 
you share a folder with other people, their 
copies of documents in that shared folder are 
synchronized on every save as well.)

2. Once you’ve installed the Dropbox software 
and have familiarized yourself with it, you’re 
ready to roll. In the Finder, open your 
Dropbox folder and notice that Dropbox has 
created some folders for you, including 
Public. Open Public and create a new folder 
inside it to hold your site. You can name it 
anything you want. For this example, I 
named mine “web”.

3. Open iWeb and select your Web site in the 
sidebar to reveal the Site Publishing Settings. 

4. Choose Local Folder from the Publish To 
pop-up menu. 

5. Enter the name for your site and your contact 
email address, and then click Choose Folder 
Location.

6. Navigate to the folder that you created in 
Step 2, then click Choose:

7. For now, that’s it. If your Web site is ready to 
publish, click the Publish Site button at the 
bottom of the iWeb window. This will 
publish the site files to the ~/Dropbox/Public/
web folder. Within a few seconds or minutes, 
depending on your connection speed and the 
size of your site, those files are synced to 
your Dropbox account “in the cloud.”
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8. Back in the Finder, navigate to the ~/
Dropbox/Public/web folder, and inside it 
you’ll see an index.html file. Control-click 
that file and from the hierarchical Dropbox 
menu in the pop-up menu that appears, 
choose Copy Public Link to put the link in 
the Clipboard. That’s the URL at which your 
Web site can be reached, and you can send it 
to friends or clients to show them the site.

9. One more step! To make sure all your links 
work properly, go back to the Site Publishing 
Settings in iWeb for your site. See that big, 
empty space where it says Website URL? 
Paste the URL that you copied in Step 8 into 
that field and then delete the index.html at 
the end of the URL. That address is the root 
URL for your new site. Click Publish Site 
again to republish your site, then go admire 
your handiwork by pasting the previously 
copied link into your Web browser.

While I didn’t have time to check all of the widgets 
and features that are part of iWeb ’09, all of those I 
was using on my sample site, including Countdown 
Timer and HTML Snippets, worked perfectly when 
served via Dropbox. Any feature that uses a server-
side capability specific to MobileMe will not work, 
so be sure to test your site functionality on Dropbox 
before sending out the URL.

[Steve Sande is Features Editor for The Unofficial 
Apple Weblog (TUAW.com) and the author of “Take 
Control of iWeb ’09.” His other titles include 
“Taking Your iPad 2 to the Max,” “Taking Your 
iPhone 4 to the Max,” and the upcoming “Taking 
Your Mac OS X Lion to the Max,” all from Apress.]
Copyright © 2011 Steve Sande. Unless otherwise noted, this 
article is copyright © 2011. TidBITS is copyright © 2011 
TidBITS Publishing Inc.Reuse governed by Creative Commons 
License.

User Group Bulletin July 2011 (Special 
Deals) 
Recent Highlights from the Apple User Group 
Resources website: 

http://appleusergroupresources.com 

- CapMac: Friends Don’t Let Friends Lose Data 
- A2Central: New User Group, Archives and More 
- PDXFCPUG: Red Giant, Final Cut Pro X and a 
MeetUp 
- FCPUG Network: SuperMeet YouTube Channel 
- Mac Computer Expo: Great Sponsors, Fun Events 
and Raffle Tickets 
- Pyers Presents: Newest Issue is Largest Ever 
- MacGroup-Detroit: Summer 2011 Photowalk 
Winners 
- Offers for User Group Leaders and Members 
including: 
• Special Offer – Texting Dots Touch Screen Pads: 
20% Discount 
• Special Offer – IDAPT Universal Chargers: 20% 
Discount 
• Special Offer – The Innovative Audioglove: 50% 
Off Clearance Sale 
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• Special Offer – Hand-e-holder for iPad: 20% 
Discount 
• Special Offer – Dolly Drive: 20% Off the Time 
Machine in the Cloud 
• Special Offer for Leaders – The Fadigear 
Audioglove: Demonstration Offer 
http://appleusergroupresources.com/?page_id=653 

The current password for vendor offers is: 

 ugvendor 

Hot Links Of The Month:
Compiled by Tom Ostertag

Apple, Inc.

Apple Reports All-Time Record Revenue 
and Earnings | Apple

Mac Software

Mac OS X Lion Available From the Mac App Store | 
Apple

Apple releases 64-bit, full-screen iTunes 10.4 and 
iWork updates | AppleInsider

AirDrop Works Only on Certain Macs | TidBITS

Burn The Mac App Store Version of OS X Lion to a 
DVD | Gizmodo

How to keep Snow Leopard when upgrading to Lion 
| MacFixit

Having Problems With WiFi in Lion? Here’s How 
You Can Fix Them | Cult Of Mac

Mac OS X 10.7: Create your own Recovery HD | 
Mac OS X Hints

Microsoft spells out Office for Mac bugs in Lion | 
MacWorld

Mac 911: Install QuickTime 7 Pro with Lion | 
MacWorld

Mac Hardware

Apple Updates Mac mini | Apple

Mac mini Server (Thunderbolt) | Low End Mac

Apple Introduces World’s First Thunderbolt Display 
| Apple

New, Faster MacBook Air | Apple

Apple Recalls Some IMac 1TB Hard Drives | 
MacFixit

New MacBook Airs, Mac minis Feature Lion 
Internet Recovery Disc-less Repair | AppleInsider

iPad

Apple Releases iOS 5 Beta 4 With Over-the-Air 
Updates | Cult Of Mac

iPod/iPhone/iTunes

Apple releases iOS 4.3.5 for iPhone, iPad, iPod 
touch | iLounge

Taking iTunes Full-Screen in Lion | iLounge

Lion-compatible version of iTunes 10.4 is now in 
Software Update, iWork '09 also updated for Lion. | 
Infinite Loop

Miscellaneous

McDonald’s Inadvertently Endorses A Mac To All 
Their Customers | Cult Of Mac

Google Books Is Back On The App Store, In Full 
Compliance With Apple’s IAP Rules | Cult Of Mac

mini’app’les Newsletter — August 2011 Page 14 of 17

http://appleusergroupresources.com/?page_id=653
http://appleusergroupresources.com/?page_id=653
mailto:tostertag@usfamily.net?subject=Hot%20Links
mailto:tostertag@usfamily.net?subject=Hot%20Links
http://www.apple.com/pr/library/2011/07/19Apple-Reports-Third-Quarter-Results.html?sr=hotnews.rss
http://www.apple.com/pr/library/2011/07/19Apple-Reports-Third-Quarter-Results.html?sr=hotnews.rss
http://www.apple.com/pr/library/2011/07/19Apple-Reports-Third-Quarter-Results.html?sr=hotnews.rss
http://www.apple.com/pr/library/2011/07/19Apple-Reports-Third-Quarter-Results.html?sr=hotnews.rss
http://www.apple.com/icloud/?sr=hotnews.rss
http://www.apple.com/icloud/?sr=hotnews.rss
http://feeds.appleinsider.com/click.phdo?i=cb8e5d9d7dc07c58bfb0e2e285c8b843
http://feeds.appleinsider.com/click.phdo?i=cb8e5d9d7dc07c58bfb0e2e285c8b843
http://feeds.appleinsider.com/click.phdo?i=cb8e5d9d7dc07c58bfb0e2e285c8b843
http://feeds.appleinsider.com/click.phdo?i=cb8e5d9d7dc07c58bfb0e2e285c8b843
http://tidbits.com/article/12365?rss
http://tidbits.com/article/12365?rss
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/nmqFctv6N-U/burn-the-mac-app-store-version-of-os-x-lion-to-a-dvd
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/nmqFctv6N-U/burn-the-mac-app-store-version-of-os-x-lion-to-a-dvd
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/nmqFctv6N-U/burn-the-mac-app-store-version-of-os-x-lion-to-a-dvd
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/nmqFctv6N-U/burn-the-mac-app-store-version-of-os-x-lion-to-a-dvd
http://reviews.cnet.com/8301-13727_7-20081187-263/how-to-keep-snow-leopard-when-upgrading-to-lion/?part=rss&tag=feed&subj=MacFixIt
http://reviews.cnet.com/8301-13727_7-20081187-263/how-to-keep-snow-leopard-when-upgrading-to-lion/?part=rss&tag=feed&subj=MacFixIt
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/hrsK0eKlgLs/105842
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/hrsK0eKlgLs/105842
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/hrsK0eKlgLs/105842
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/hrsK0eKlgLs/105842
http://feeds.macosxhints.com/click.phdo?i=682d1c72bbaf607eb970fe0aaa47d02d
http://feeds.macosxhints.com/click.phdo?i=682d1c72bbaf607eb970fe0aaa47d02d
http://rss.macworld.com/click.phdo?i=c419c69b956d5f89a0723cc11e9b93fd
http://rss.macworld.com/click.phdo?i=c419c69b956d5f89a0723cc11e9b93fd
http://rss.macworld.com/click.phdo?i=624f8c4d0207acdbf4bf2b481be416ca
http://rss.macworld.com/click.phdo?i=624f8c4d0207acdbf4bf2b481be416ca
http://www.apple.com/macmini/?sr=hotnews.rss
http://www.apple.com/macmini/?sr=hotnews.rss
http://lowendmac.com/mini/mac-mini-server-2011.html
http://lowendmac.com/mini/mac-mini-server-2011.html
http://www.apple.com/displays/?sr=hotnews.rss
http://www.apple.com/displays/?sr=hotnews.rss
http://lowendmac.com/imacs/imac-mid-2011.html
http://lowendmac.com/imacs/imac-mid-2011.html
http://reviews.cnet.com/8301-13727_7-20082309-263/apple-recalls-some-imac-1tb-hard-drives/?part=rss&tag=feed&subj=MacFixIt
http://reviews.cnet.com/8301-13727_7-20082309-263/apple-recalls-some-imac-1tb-hard-drives/?part=rss&tag=feed&subj=MacFixIt
http://feeds.appleinsider.com/click.phdo?i=456186ea5ce8322c2f2688c864557df2
http://feeds.appleinsider.com/click.phdo?i=456186ea5ce8322c2f2688c864557df2
http://feeds.appleinsider.com/click.phdo?i=456186ea5ce8322c2f2688c864557df2
http://feeds.appleinsider.com/click.phdo?i=456186ea5ce8322c2f2688c864557df2
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/TsRr-5tSmjU/the-weeks-best-ipad-apps
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/TsRr-5tSmjU/the-weeks-best-ipad-apps
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/TsRr-5tSmjU/the-weeks-best-ipad-apps
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/TsRr-5tSmjU/the-weeks-best-ipad-apps
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/jv4OfTxMc5E/101305
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/jv4OfTxMc5E/101305
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/jv4OfTxMc5E/101305
http://feedproxy.google.com/%7Er/cultofmac/bFow/%7E3/jv4OfTxMc5E/101305
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/3hYtkllBDQo/the-heart-healthy-iphone
http://feeds.gawker.com/%7Er/gizmodo/full/%7E3/3hYtkllBDQo/the-heart-healthy-iphone
http://feeds.arstechnica.com/%7Er/arstechnica/apple/%7E3/CoHIHaqUsws/ios-5-brings-nitro-speed-to-home-screen-web-apps.ars
http://feeds.arstechnica.com/%7Er/arstechnica/apple/%7E3/CoHIHaqUsws/ios-5-brings-nitro-speed-to-home-screen-web-apps.ars
http://feeds.arstechnica.com/%7Er/arstechnica/apple/%7E3/CoHIHaqUsws/ios-5-brings-nitro-speed-to-home-screen-web-apps.ars
http://feeds.arstechnica.com/%7Er/arstechnica/apple/%7E3/CoHIHaqUsws/ios-5-brings-nitro-speed-to-home-screen-web-apps.ars
http://howto.cnet.com/8301-11310_39-20069482-285/how-to-stay-synced-with-icloud/?part=rss&tag=feed&subj=MacFixIt
http://howto.cnet.com/8301-11310_39-20069482-285/how-to-stay-synced-with-icloud/?part=rss&tag=feed&subj=MacFixIt
http://howto.cnet.com/8301-11310_39-20069482-285/how-to-stay-synced-with-icloud/?part=rss&tag=feed&subj=MacFixIt
http://howto.cnet.com/8301-11310_39-20069482-285/how-to-stay-synced-with-icloud/?part=rss&tag=feed&subj=MacFixIt
http://appleusergroupresources.com/?p=2479
http://appleusergroupresources.com/?p=2479
http://appleusergroupresources.com/?p=2479
http://appleusergroupresources.com/?p=2479


Members Helping Members
Need Help? Have a question the manual doesn’t 
answer? Members Helping Members is a group of 
volunteers who have generously agreed to help. 
They are just a phone call or an email away. Please 

call only during the appropriate times, and only if 
you are a current mini’app’les member and own 
the software in question.

...................Apple II / IIGS Software & Hardware NV
....................................AppleWorks / ClarisWorks 3, 4

..........................................................Classic Macs NV
.................................Cross-Platform File Transfer 2, 3

........................................................FileMaker Pro NV
.....................................................................iMacs NV

...................................................Intel-Based Macs NV
.........................................................................iPhoto 3
........................................................................iMovie 6
.........................................................................iWork 4

.........................................................Mac OS Classic 3

..............................................................Mac OS X NV
.....................................................Microsoft Excel 2, 5
......................................................Microsoft Word 2, 5

................................................................Networks NV
.................................................................New Users 1
.............................................................PhotoShop NV

..............................................................QuarkXPress 5
..................................................................Quicken NV

.........................QuickBooks and QuickBooks Pro NV
..........................................................VectorWorks NV

1. Les Anderson 651-735-3953 anderslc@usfamily.net DEW
2. Tom Ostertag 651-488-9979 tostertag@usfamily.net DEW
3. Bruce Thompson 763-546-1088 bthompson@macconnect.com EW
4. Pam Lienke 651-457-6026 plienke@aol.com DEW
5. Ron Heck 651-774-9151 ronheck@comcast.net DEW

D = Days, generally 9 a.m. to 5 p.m.
E = Evenings, generally 5 p.m. to 9 p.m.
W= Weekends, generally 1 p.m. to 9 p.m.
NV = No Volunteer

Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of these 
volunteers can also be contacted on our forums. We appreciate your cooperation.

Mini’app’les needs more volunteers for Members Helping Members — If you are willing to 
be a Members Helping Members volunteer, please send an email message to Membership Director Les 
Anderson or contact him on our forums with your name, telephone number, contact hours, and the 
software and hardware areas you are willing to support.
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Mini’app’les Membership Application and Renewal Form
Membership cost is $15.00 for one year. To pay electronically using PayPal, visit the mini’app’les website.

If you prefer to pay by check, use the form below. Please make your check payable to “mini’app’les”.

Name:   

Company (if mailed to):   

Address:  

City, State, Zip:   

Phone # (home):   

Phone # (work):   

Phone # (cell):   

Membership ID # (if renewal):   

Email:   
Your email address will NOT be sold, shared, or distributed. It will be used only for official mini’app’les business such as distribution 
of the newsletter and membership renewal reminders.

  Check if this is a change of address notice

  Check if you want to volunteer

  Check if you want to be added to “Members Helping Members”

  Check if you were referred by a club member (if so, please give member’s name)

Please mail this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796

Thank you for your support!

Benefits of mini’app’les Membership

• Access to the mini’app’les online forums. Post questions and/or answers about issues, trouble shooting, 
products, buying and selling, special events, discounts, and news about Apple and the mini’app’les club.

• Access to our Members Helping Members network of professional and advanced users of Apple technologies. 
These members volunteer their time to help other members with software, hardware, and other Apple related 
issues.

• A variety of Mac Special Interest Groups (SIGs) that meet each month.

• Multi-SIG meetings and workshops to help members with computer problems. You can bring your equipment 
to these events and receive support from knowledgeable Mac users to help diagnose your problem(s).

• Participation in drawings for computer hardware, software, and other computer related materials.

• Discounts from vendors and manufacturers. Refer to the on-line forums for current offers.

mini’app’les Newsletter — August 2011 Page 16 of 17

http://www.miniapples.org
http://www.miniapples.org


mini’app’les
the minnesota apple computer users group, inc.

Introduction — This is the newsletter of mini’app’les, the 
Minnesota Apple Computer Users’ Group Inc., a Minnesota 
non-profit club. The whole newsletter is copyrighted © by 
mini’app’les. Articles August be reproduced in other non-profit 
User Groups’ publications except where specifically copyrighted 
by the author (permission to reproduce these articles must be 
given by the author). Please include the source when reprinting.

The mini’app’les Newsletter is an independent publication not 
affiliated, sponsored, or sanctioned by Apple, Inc. or any other 
computer manufacturer. The opinions, statements, positions, and 
views are those of the author(s) or newsletter staff and are not 
intended to represent the opinions, statements, positions, or 
views of Apple, Inc., or any other computer manufacturer. 
Instead of placing a trademark symbol at every occurrence of a 
trade-marked name, we state we are using the names only in an 
editorial manner, to the benefit of the trademark owner, with no 
intention of infringement of the trademark.

Questions — Members with technical questions should refer to 
the Members Helping Members section or bring their questions 
to an appropriate SIG meeting. Please direct other questions to 
an appropriate board member. 

Dealers — Mini’app’les does not endorse specific dealers. The 
club promotes distribution of information that August help 
members identify best buys and service. The club itself does not 
participate in bulk purchases of media, software, hardware, and 
publications. Members August organize such activities on behalf 
of other members.

Submissions — We welcome contributions from our members. 
Perhaps you’re using new software that you just can’t live 
without. Maybe you have a new piece of hardware that you find 
extremely useful and of high quality. On the other hand, you 
might be struggling with problematic software or hardware.
Why not share your experience with other members by writing a 
product review? Doing so August steer others towards quality 
products or help them avoid the problems you August be having.

Submissions must be received by the 15th day of each month to 
be included in the next month’s newsletter. Please send 
contributions directly to our post office box (mini’app’les, PO 
Box 796, Hopkins MN 55343), or email them to 
miniapples@mac.com.

The deadline for material for the next newsletter is the fifteenth 
of the month. An article will be printed when space permits and, 
if in the opinion of the Newsletter Editor or Publications 
Director, it constitutes material suitable for publication.

This newsletter was produced using Apple’s Pages word 
processor.

Board of Directors
President Tim Drenk
 952-479-0891
 timdrenk@miniapples.org

Vice President Jeff Berg
 781-350-0598
 jeff@purpleshark.com

Secretary Joel Gerdeen
 763-607-0906
 jgerdeen@mac.com

Treasurer Bob Demeules
 763-559-1124
 osx.sig@mac.com

Membership Director Les Anderson
 651-735-3953
 anderslc@usfamily.net

Publications Director Tom Ostertag
 651-488-9979
 tostertag@usfamily.net

SIG Director Kevin Strysik
 65l-489-4691
 strysik@mac.com

Director at Large Bruce Thompson
 763-546-1088
 bthompson@macconnect.com

Membership  Sandy Foderick
Coordinator sfoderick@mac.com
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